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Important!  The browsers supported for the application are Internet Explorer 6 or 7 and 
Mozilla Firefox 2.  Netscape should no longer be used. 
 
 
 
Following the court’s upgrade to CM/ECF Release 3.2, Internet Explorer (IE) users should configure Internet 
Explorer to check for newer versions of stored pages every time they start their browser.  
 
 

1. On the Internet Explorer menu bar, click Tools and then click Internet Options.  The Internet Options 
dialog box appears. 
 

2. Depending on your browser version, do one of the following: 
 

¾For Internet Explorer 6 
 
a. Under Temporary Internet Files, click Settings.  The Settings dialog box appears. 
 
b. Under the Check for newer version of stored pages, click to select “Every time you start Internet 

Explorer.” 
 

c. Click Ok. 
 

¾For Internet Explorer 7 
 
a. Under Browsing history, click Settings.  The Temporary Internet Files and History Settings 

dialog box appears. 
 

b. Under the Check for newer version of stored pages, click to select “Every time I start Internet 
Explorer.” 

 
c. Click Ok.  The Internet Options dialog box appears. 

 
3. Click Ok. 
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CASE NUMBER LOOK-UP 
 
� When the case number is entered a “Find This Case” button will display as soon as you begin 

typing and the “Next” button becomes active. 
 

 
 

� After clicking on “Find This Case” matches are displayed on the same screen with radio buttons.  
The “Hide Case List” button will allow you to control what you see.  With the correct case 
selected, you must again click Next, or press Enter, to proceed. 
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CASE OPENING 
 

� Prior to version 3.2, when opening a bankruptcy case, the default value for the chapter was 7.  
Now, the chapter has no default value and you must select the chapter from the drop-down.  

 
� Cases will be automatically assigned to a division based on the debtor’s county, even if the case 

is a joint filing with different counties listed. 
 

� Previously, any confirmation or error messages displayed for that process showed only the code 
of the relevant county; now, all such messages include both the code and the county name. 

 
� The Notice of Bankruptcy Case Filing, which is accessible via a link at the end of the case 

opening process, now labels the filing date as “Filed” rather than “Filed Electronically.” 
 
Note:  The Notice of Bankruptcy Case Filing link can also be found under Query. 

 

 

 
 

� Involuntary Case Opening 
 
The following fields have been deleted from involuntary case opening: Prior filing within 8 
years, Asset notice, Estimated number of creditors, Estimated Assets, Estimated Liabilities. 
 

� Case Opening: Chapters 7, 11 and 13 individual debtors’ data collection. 
 
A new screen appears after the screen that collects Type of debtor/Nature of business.  This 
screen collects data needed by the Executive Office of the US Trustees (EOUST).   
 
See the new screens below: 
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CHAPTER 7 
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CHAPTER 11 

 
 
 
CHAPTER 13 
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CLAIMS/CREDITORS 
 

� Search for a Creditor.  
 

The “Search for Creditor” screen when filing claims now includes a blank value so that all types 
of creditors can be retrieved and multiple creditor types can be selected.  The type of creditor is 
displayed on the search results list. 
 

 
 

If creditors are returned from a search and you expand the pull-down list to select a creditor, a 
pop-up box will appear when you select a creditor.  This pop-up window shows: 

o whether the creditor you selected has filed a claim or not, 
o the name, address and claim number for that creditor, 
o the number of claims filed for that creditor, and 
o if a claim is no longer owned by that creditor, the number appears in 

parentheses. 
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Holding the cursor over a creditor’s name will now show the number of claims that have been 
filed for that creditor.  If the claim has been assigned, hovering over the creditor name will 
display both the assignee and original claimant. 
 
Note: Users of Internet Explorer Version 6 will not see this display. 
 

 
 
Previously, if no creditors were returned from a search, an empty selection list was displayed.  
Now, a “No creditors found” message is shown.  In addition, there is a “Change search criteria” 
link, which returns you to the “Search for Creditor” screen. 

 

 
 
 

� Claim Filing – Proof of Claim: Amended Claim 
 

Prior to version 3.2, a claim was accepted as amending another claim only if the creditor selected 
for the amended claim was the same as the creditor for the original claim.  Now, the amendment 
can have a different creditor. 
 
A Find button has been added to the “Amends Claim #” box.  You can click this button to 
display claims that have been filed in the case in a separate window. 
 
Note: If the original claim number is typed in the box first, only that claim is displayed. 
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Users can click on the column header for Creditor Name or Claim # to sort the list by that item. 
 

 
 

¾When selecting a claim that was filed by the same creditor, the values from the original 
filing are copied into the Proof of Claim screen for editing. 

 
By clicking on the Creditor Name, the claim number will be filled in the Amends Claim # box 
on the Claim Information screen. 

 
¾If you select a claim to be amended that was filed by a different creditor, a 
confirmation/warning screen is displayed.  Click Continue and the values from the original filing 
are copied into the Proof of Claim screen for editing. 
 

 
 
Note: Do Not Use this procedure to transfer a claim from one creditor to another. 
 
 
¾A new option (“Clear” box) has been added to the Proof of Claim screen so that you can easily 
clear the values that are displayed: 
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� Creditor Maintenance: add a creditor 
 

Members of the creditors’ committee are now designated as either an entity (business) or 
individual.  An “Entity” check box has been added to the detail screens and is enabled if the 
“Yes” radio button is selected for “Creditor Committee.” 
 
 

 
 
Previously, the Notice of Electronic Claims Filing screen showed only the name and email 
address of recipients (and names of those not notified electronically).  Now, notices of electronic 
filings for attorney recipients’ show “on behalf of,” the type and name of the party being 
represented, along with the attorney email address. 
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DOCKETING 
 

� Joint Debtor Dispositions. 
 
The reference information near the top of the docketing screens now shows the disposition and 
dates for both debtors in joint cases (e.g. dismissed, discharged, and date). 
 

 
 
� Associated Cases. 

 
The lead case number is now a hyperlink to that case on the associated cases warning screen, 
when docketing. 
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Note:  Adding corporate parents/affiliates is not only available during case opening.  You can enter 
corporate parents and other corporate affiliates for a party when docketing a Corporate Ownership 
Statement.   

 
� Adding A Party: Corporate parent/affiliate.  
 
¾The Corporate parent button on the Debtor Information screen is now labeled “Corporate 
parent/affiliate.” After clicking on the Corporate parent/affiliate button, users will be prompted 
to search for the parent/affiliate being added.  [Type the name in the “Business name” field and 
click the Search button.] 
 
If there is no match for the parent/affiliate (“No person found”), users will need to click on the 
Create new corporate parent/affiliate button.  
 

 
 
Users must also select the Type: corporate parent or corporate affiliate from the drop down 
and leave the check mark in the Entity box. 

 
 
Note: Repeat this process if there is more than one corporate parent or affiliate. 
 
¾When an attorney was added for a new party, the cursor was placed in the Bar ID field of the 
“Search for an attorney” screen.  Now, the cursor is in the last name field. 
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� Application for Payment of fees. 
 

If a fee or an expense amount has been entered, then the “Type” of professional from the 
selection list is required.  Conversely, if no fee or expense is entered, then the professional type 
can be blank. 
 

 
 

� Docketing an event that requires a fee. 
 
When you are docketing an event that requires a fee, you are presented with a pop-up window 
relating to payment.  This pop-up window contains a message warning against using the Back 
button and now another warning message against closing the window by clicking the X in the 
upper right corner.  
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� Notice of Electronic Filing (NEF) 
 
¾The language on the NEF regarding free looks has changed: 

***NOTE TO PUBLIC ACCESS USERS*** Judicial Conference of the United States policy 
permits attorneys of record and parties in a case (including pro se litigants) to receive one free 
electronic copy of all documents filed electronically, if receipt is required by law or directed by 
the filer. PACER access fees apply to all other users. To avoid later charges, download a copy of 
each document during this first viewing. However, if the referenced document is a transcript, the 
free copy and 30-page limit do not apply. 

¾For Written Opinions, the note still reflects: 

***NOTE TO PUBLIC ACCESS USERS*** There is no charge for viewing opinions. 

¾When clicking a document link on an NEF for which a free look is available, the following 
notice is displayed on the document selection screen: 
 
“To view the main document and its attachments without incurring a PACER fee, click on the 
hyperlinks displayed on this menu.  You will incur a PACER fee to view CM/ECF documents 
from hyperlinks within the documents.” 

 
¾Notices of electronic filings (NEF) now show the party being represented (includes party role, 
first and last name) along with the attorney email address.  If multiple parties are represented, 
only the first one is shown from a list sorted by attorney last name, party role description, party 
first name, and party last name. 
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MISCELLANEOUS 
 
� Pressing the Enter key gives you the same result as using the mouse when clicking the Run 

Query, Run Report, or Submit buttons.  
 
� Previously, when you displayed a PDF document and selected the “Save a Copy” option (Adobe 

Reader plug-in), a default file name of “show_case_doc.pdf” or “show_claim_doc.pdf” 
displayed.  Now, a default name, which varies with the browser, is generated. 

 
� Previously, the party search results box only displayed last, first, and middle names when 

Adding/Creating a New Party.  Now, the generation, address line, city and state are also 
displayed, making it easier to distinguish between similar persons. 

 

 
 

� The label for Social Security number has been changed to “SSN/ITIN” since an individual tax 
identification number may be used.  The label for federal tax identification number has been 
changed to “Tax ID/EIN” to show that it is also referred to as “employer identification number.” 

 
� Now, you can change the client code as needed when you move among District, Bankruptcy, and 

Appellate court CM/ECF applications. 
 

� Document links: 
 
¾It is now possible for PDF documents to include active links to documents in the original case. 
 
¾If your Adobe Acrobat option to “Display PDF in browser” is NOT set, you may have 
problems with the display of screens when viewing a document from a link.  You can change the 
setting, found via the “Preferences” option on the Acrobat Edit menu; select the “Internet” 
category. 
 
Note:  Refer to the Viewing/Downloading Multiple documents section of this guide for 
more information about document links. 
 
 
 



 
Guide to new features in CM/ECF Version 3.2 & 3.3.1 for Attorneys & Law firm staff 

 
 

 
16

QUERY 
 

� Check boxes for open and closed cases have been added to the screen to narrow your search and 
you can query by Employer Identification Number (EIN). 
 

� The abbreviated case data that appears at the top of the screen now includes, dismissed and 
discharged dates for each debtor in a joint case. 
 

� Case Summary 
 
¾When running a query for a bankruptcy case, Nature of debt is now displayed (e.g. consumer 
or business). 
 
¾When querying an adversary proceeding, the lead case number is displayed as a link to the 
docket report. 
 

 
 
¾The discharge date, dismissed date, and the disposition for the joint debtor are displayed in 
joint bankruptcy cases. 
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� Associated Cases 
¾Closed cases are now marked with “(closed)” after the case title. 
 

� Corporate Parents   
 
¾This option is now labeled “Corporate Parents/Affiliates.”  

 
¾On the output of this option, corporate parents are labeled “cp” and corporate affiliates are 
labeled “ca”. 

 
¾Instead of repeating party information for each corporate parent, this option now displays the 
party information once on the left side of the screen, with corporate parents and other affiliates 
listed to the right of the party. 

 
� Deadlines/Hearings (Query, click Deadline/Schedule) 

 
¾The hearing judge is now displayed and there is also an option to sort by hearing judge. 
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REPORTS 
 
� Docket Report 

 
¾Currently CM/ECF shows one disposition on a case and assumes that joint debtors will have 
the same disposition on the same date.  With CM/ECF version 3.3, bankruptcy cases that are 
closed on or after March 9, 2009, will show the joint debtor’s disposition, discharge date 
and dismissed date, in addition to the debtor’s disposition. 
 
¾The dockets of bankruptcy cases and adversary proceedings docket now contain links to 
associated cases, while the adversary proceeding docket also includes a link to the Lead 
bankruptcy case docket.  
 

 
 

 
 
 
¾There are two (2) new options when running a docket report: 
 

1. View Multiple Documents. 
2. Create Appendix. 

 
Note: The maximum file size for the combined PDF is 2 megabytes. 
 
i. View Multiple Documents: 

 
This option allows you to view or download a set of selected PDF documents as one 
entity.  After you click Run Report, you are presented with a screen for selecting docket 
entries: 
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If View Selected is chosen, a PDF file with all the documents that are associated with the 
selected entries is displayed. 

 
If Download Selected is chosen, a compressed (.zip) file that can be saved is produced and 
each document within the compressed file is a separate PDF.   

 
Be advised that if your operating system is Windows 2000, you will need software 
(e.g. WinZip) in order to open compressed files. 

 

 
 

A PACER billing receipt for the selected documents is shown before the PDF files are 
displayed or downloaded.  
 
If the file size to be displayed/downloaded exceeds the limit specified by the court, the 
display/download will not occur and file size information is shown so that you can make 
different selections that will be within the total file size limit. 
  
A similar capability has been added to the Document Selection Menu.  When you click 
the document number link for a document that has attachments (in a docket report, a 
history/document query, etc.) you may view the main document and all attachments 
together by clicking the View All button, instead of having to view and save each 
document separately.  In addition, a “Download All” option is also presented. 
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Note: There is a PACER fee of 8 cents per page for all pages in all the documents 
selected, as well as, the file size restriction on the amount of data viewed/downloaded 
as described above. 

 
ii. Create Appendix 

 
When this option is selected, other options are disabled and you can choose those 
documents you want to include in your appendix. 
 
This option produces a single PDF file that includes both a complete docket sheet AND 
images of all the documents that you select.  After you click Run Report, you are 
presented with a screen for selecting among the docket entries that matched the date and 
document number criteria.  
 
The “Footer format” box allows you to choose text options that would appear on each 
PDF page.  The “Footer format” defaults to <pagenum>, which numbers the pages 
consecutively. 
 
Clicking View Selected displays the Appendix file with all the documents associated with 
the selected entries. 
 

 
 

You will be charged the PACER fee of 8 cents per page for all pages of the documents 
selected and for the number of pages of the docket generated. Therefore, if a case has a 
very large docket, you may not want to use this option, but rather assemble your appendix 
using the view multiple documents option thereby eliminating the docket from the 
package. 
 

o When selected, the “View multiple documents” and “Create Appendix” option 
creates a single PDF from multiple documents, which may include hyperlinks 
within the same PDF to other CM/ECF documents. 

 
The links in the consolidated document are the same as those in the original 
documents and may point to the beginning of the document or to a specific page 
in the document.  Therefore, clicking a link will display the reference 
document in a new window, even if the referenced document is included in the 
consolidated PDF and would thereby incur an additional fee.   
 
To avoid additional PACER fees, you should check the link description and 
look for the referenced document in the consolidated document rather than 
clicking the link. 
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¾A “Show Associated Cases” link has been added to the docket report that displays a table of 
associations. 
 
¾On the docket report for adversary proceedings the “Related BK” label was changed to “Lead 
BK Case.”   The “Lead Bk Case” value is a link to the docket report for that case. 
 

 
 

� Cases Report 
 

¾Previously, when selecting both open and closed cases, the report would only display a count 
of “Total number of cases” at the end of the report.  Now, the end of the report reflects the 
number of open cases and closed cases when you select both open and closed cases to be 
included. 
 

   
Prior to 3.3.1             3.3.1 

 
 
¾Previously, when the “Party Information” box was checked the party role (e.g. debtor) was not 
shown.  The party “Role” is now displayed with the party name. 
 
¾When a joint bankruptcy case is closed, the disposition, discharge date, and dismissed date for 
each debtor are displayed.  In addition, the format of the data record is the same for all case types 
(ap, bk, mp) and whether or not the Party information box was checked. 
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� Claim Register Report 
 
¾Icons for pop-up calendars have been added for the Filed “from” and “to” dates. 
 

 
 

¾Enhancements to the claims register report include: 
o “Claimant History” link displayed in the Creditor section, and  
o “Details” link in the History section 

 
These links provide more details of the claim history, for instance, if a claim was transferred or 
if changes were made to the initial claim filing via editing. 
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¾The silver ball icon for the Notice of Electronic Claims Filing is only accessible if you are 
logged in with a CM/ECF account. 

 

 
 

¾An error message no longer displays when the name of the creditor who transferred a claim 
has been modified. 

 
� Judgment Index Report (New) pursuant to Bankruptcy Rule 5003(c).  

 
¾This report lists docketed events that the court has designated to be “judgments.” 

 

 
 
Note: The Case Number/Title link takes you to the docket report. 
 

� Calendar Events Report 
 

¾Previously, the judge selection applied only to the judge assigned to the matter (hearing judge).  
Now, the “Judge” label on the screen includes an “Unassigned hearing judge” option in the judge 
selection list and you can select whether the hearing judge, case judge, or both should be 
considered by selecting one of the corresponding radio buttons. 
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¾The last case number requested in the current CM/ECF session is now filled in by default in 
the case number field. 
 
¾The “Calendar events” label on the screen has been changed to “Type.” 
 
¾A blank option for the “Office” selection item has been added as the default. 
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� Docket Activity Report 
 

 
 

 

 
 
¾Check boxes for Open cases and Closed cases were added to the selection screen. 
 
¾The selection for “Only cases to which I am linked” (shown above) will only appear when you 
are logged in with a CM/ECF filing password, not a PACER password. 
 
¾The Case column now contains a value of yes or no for “Assets.” 
 
¾The Category/Event column of the report now displays the Event name when the full docket 
text option radio button is selected, in addition to the summary text option. 
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NEW SEARCH OPTION 
 
This new feature located at the top of the menu bar allows you to search Menus and Filing Events by using 
key words. 
 
Note: You can still access menu items by simply clicking on the menu title. 
 

� Menus and Filing Events 
 
Click Search on the main blue menu bar.  A small pop-up window appears for entering the text 
to be searched and it is not case sensitive. 

 
Once you enter text in the search box and click the magnifying-glass icon (or press the Enter 
key) the results are displayed on the screen, with the search string characters highlighted. 

 
The results will show all entries with those words as hyperlinks and which Menus they are 
located under so you can go directly to it.  
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� Docket Event Search 
 
Docketing events are now searchable by using the search feature within a particular Menu while 
filing, making it easier to find the proper ECF event to docket a pleading.  For example, if you 
are filing a motion and you must choose from a long list of events it is no longer necessary to 
scroll through the list to find the desired event.  A text box is provided above the list: 
 

 
 
By entering some word fragments from the event description (e.g., sanction), a full list will be 
displayed of those events that match: 
 

 
 
Clicking on an event from the Available Events moves the event over to the Selected Events box 
on the right. 
 
You may also select multiple events by holding the Ctrl key and clicking each event.  The 
events you have chosen will display on the right in the “Selected Events” box. 
 
If you want to remove any event that has already been selected, simply click on the event in the 
right side column. 
 
Note:  Only letters and numbers are searched; other characters (e.g. -, /, “-“) are ignored. 
 
¾When a docket event allows you to enter multiple case numbers (e.g. Batch Filings and Multi-
Case Docketing) and you paste in a case list (with Ctrl-V), the individual case numbers are now 
automatically entered into separate boxes. 
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TRANSCRIPTS 
 
Implementation of Judicial Conference Policy.  Please refer to our separate documentation regarding 
transcripts at: http://www.nysb.uscourts.gov/pdf/TranscriptRestrictionsRedactionGuidelines.pdf. 
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UTILITIES 
 
� View Your Transaction Log 

 
Changes to the style of column headers and font were made in an effort to standardize the format 
of ECF reports. 

 
� Review Billing History 

 
When you click the link “Review Billing History” you are automatically redirected to the 
PACER Service Center server, which produces the report.  In this new window, you can search 
for transactions in the current and previous months, for a specific court or all courts.  The data is 
retrieved from the PACER Service Center’s central billing transaction database and formatted 
according to the options you select. 

 

 
 
http://pacer.psc.uscourts.gov or call PACER Service Center at (800) 676-6856. 
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� Court Information 
 

¾This link provides users with general information, such as the maximum size of PDF files 
(5MB).  In addition, “Maximum Merge Document Size” details have been added to this section. 
 
¾By clicking the CM/ECF logo on the upper left hand corner of the blue menu bar, a summary 
of court information is displayed and a link [Further court information] that provides full court 
information is included. 
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CROSS-DOCUMENT HYPERLINKS 
 
These instructions describe the steps for creating a hyperlink in a PDF document which points to 
another document in the CM/ECF database.  The document being referenced can be one that was 
previously filed, or one that is being filed in the same event with the referencing document. The 
steps to create a hyperlink and to generate documents in PDF format are similar whether you are 
using WordPerfect or Word to create documents; differences are noted. 
 
¾Creating a hyperlink to a document already filed in the electronic case file 
 
A link can be made to another document in any database in the Federal Courts -- District, 
Bankruptcy or Appellate.  
 

1. Access CM/ECF and run the docket report for the case in which the document was filed. 
2. Locate the document among the docket entries. 
3. Copy the URL of the document to the clipboard. DO NOT copy the URL from the 

browser’s address bar when the document is open. Instead, hover over the document 
link and click the right mouse button (the document link displays after the docket date 
and is represented by an icon or a number with an underscore, e.g., 2). Select Copy 
Shortcut or Copy Link Location from the selection list (the option you see depends on 
your browser). 
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4. Open the word processing document. In the document, highlight the citation text for which 
you wish to create the hyperlink. 

 

 
 
 

5. Create the hyperlink.   
 
Note:  The procedure is different depending on the word processing software that you 
use – specific instructions for WordPerfect and Word are given on the next two pages. 



 
Guide to new features in CM/ECF Version 3.2 & 3.3.1 for Attorneys & Law firm staff 

 
 

 
33

If you are using WordPerfect 
 
Select Hyperlink from the Tools menu: 
 

 
 
The Hyperlink Properties window opens: 
 

 
 
Paste the URL into the Document/Macro box with Ctrl-V. 



 
Guide to new features in CM/ECF Version 3.2 & 3.3.1 for Attorneys & Law firm staff 

 
 

 
34

If you are using Microsoft Word 
 
Select Hyperlink from the Insert menu: 
 

 
 
The Insert Hyperlink window opens: 
 

 
 
Paste the URL into the Address box with Ctrl-V. 
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6. If the citation is to a specific page in the document, append to the URL “?page=”, followed 

by the page number, e.g., 
 

https://ecf.txwb.uscourts.gov/docs1/001010708409?page=23 
 

Note: Because of an incompatibility between the browser and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer. 

 
7. Click the OK button to close the hyperlink dialog box. 
 
8. The hyperlink text is now underlined and blue (or whatever color is specified for links), 

indicating a hyperlink has been created.  Save the word processing document. 
 

9. Produce the PDF file. 
 

You must NOT use the “Print” option in the word processing program, since the hyperlinks 
will not be preserved [you may use this option if there are no hyperlinks in the document]. 
 
Instead, use one of these methods: 

 
a. If you are using a version of WordPerfect that has a “Publish to PDF” or “Publish to…” 

option on the File menu, select it (if it is “Publish to..”, select “PDF” from the choices).  
If you are using an earlier version of WordPerfect that does NOT have one of these 
options, you must upgrade to Version 11 or higher. 

 
b. If you are using a version of Word that has an “Adobe PDF” menu, select the “Convert 

to Adobe PDF” option from it. 
 

c. If you are using Word but do not have an “Adobe PDF” menu, close the Word file. 
Open the Adobe Acrobat application. From the File menu, select Create PDF and 
From File...: 

 

 
 

A navigation window opens; use it to find and select the document, then click Open. 
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A series of windows open as the document is converted. When the conversion is complete, 
the document is displayed in an Adobe Acrobat window, with an active hyperlink. 

 
Close the Acrobat file. Respond “Yes”’ to the “Save changes” prompt and store the PDF 
file in an appropriate directory. 

 
10. Docket an event and upload the PDF file to the docket entry as usual. 
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¾Creating hyperlinks between documents filed in the same event 
 
Instead of linking to a previously filed document, you can link a document to one that will be filed 
in the same event (e.g., create a hyperlink in the main document to an attachment). The procedure is 
different, since the referenced document does not yet have an address in CM/ECF. 
 
When you create a link, it points to the referenced document where it exists on your local PC or 
server; when the documents are filed in CM/ECF, the link is converted to a CM/ECF URL. 
 

1. Create PDF versions of any secondary documents (e.g., attachments), which will be 
referenced by the main document. See step 9 in the previous section. 

 
2. Open the main document in the word processing program (i.e., the document that will have 

hyperlinks to the secondary documents). 
 

3. Select the text in the main document that will be displayed as the hyperlink. 
 

4. Create the hyperlink: 
 

If you are using WordPerfect 
 
Select Hyperlink from the Tools menu. 
 
Click the folder icon to the right of the Document/Macro box: 
 

 
 
Navigate to the referenced PDF document and click Select; click OK in the Hyperlink Properties 
box. 
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If you are using Microsoft Word 
 
Select Hyperlink from the Insert menu.  Navigate to the referenced PDF document, select it, and 
click OK: 
 

 
 

5. If the citation is to a specific page in the document, append to the URL “?page=”, followed 
by the page number, e.g., 
 
https://ecf.txwb.uscourts.gov/docs1/001010708409?page=23 
   
Note: Because of an incompatibility between the browser and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer. 
   

6. Click the OK button to close the hyperlink dialog box. 
 

7. The hyperlink text is now underlined and blue (or whatever color is specified for links), 
indicating a hyperlink has been created. Save the word processing document. 
 

8. Follow the instructions in step 9 of the previous section to produce the PDF version of the 
“main” document. 
 

9. Docket an event and upload the main document and attachments as usual. 
 


